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Quick Guide to e-learn.sdu.dk (Blackboard) for Students
You access Blackboard via single sign-on, sso.sdu.dk/, or the address: e-learn.sdu.dk/

When you have logged on, you find yourself in the *‘Courses’ area. “‘Courses’, ‘My Page’

and ‘Content System’ are the three main sections in Blackboard. Under the ‘Help’ tab

you can find guides for different functions in e-learn.sdu.dk (Blackboard). You navigate

between these main areas by clicking on the tabs on the top:
My Places Help Logout

Courses My Page Content System e Connect Systermn Admin Help

This manual briefly introduces each of the main areas, hereby enabling you to use e-
learn.sdu.dk.

1) COURSES

Under ‘Courses’ you’ll find:

1) My Announcements’: Here you find important messages from all your
instructors. These may concern cancellations/rescheduling of class sessions, extra
readings for classes etc..

2) ’ My Courses’ & *Course List’: A list of the courses in which you are enrolled

3) ’ INFO from System Administration’: Information on the use of e-learn.sdu.dk,
for instance information on new or changed features, or tips concerning features
already available via e-learn.sdu.dk which you may not be familiar with. Info om
e-learn.sdu.dk will also be used to give notice of planned shutdowns of e-
learn.sdu.dk.

4) In the box 'Hot Links' box you'll find quick links to specific functions. Like to
withdraw from the courses you no longer are affiliated with.

1.2) MY COURSES - how courses work | &
On the left, you’ll find the course catalogue of the courses
created in the SDU Blackboard. You will altso find a search
feature for searching among courses. In the middle, the
courses in which you are enrolled are displayed.

# Bh9 Masterkursus »
(roberts_videokursus)
Home Page
Announcements

For each course, there is a Blackboard section. You go to LT

this by clicking on the course name under ‘Courses’. You

navigate within the course via the menu in the left hand side:  [REEEEElS
Groups

Tools
Help

Documents
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Note that not all departments/faculties use this structure and these terms. Your course
spaces may therefore look different. These spaces are the most frequently used:

The Announcement button: Here you find all messages posted by the instructor(s) — or by
others involved in managing the course.

Information: Here you find information relevant for the whole span of the course, e.g.
reading list and course schedule.

Documents: Here you will find powerpoint slides and other teaching materials.
Discussions: Here you gain access to the course forum.
External Links: Here, external links relevant to the course may be found

Tools:

Address Book: Add and store friends’ addresses, phone numbers etc. Add a
contact by clicking on ‘Add Contact’.

Calendar: Contains your personal planned events as well as events entered by
your instructor(s).

Course Portfolios: Contains course portfolios.

CourseWiki: The class may cooperate in developing a wiki.

Digital Drop Box: From here you can send assignments, papers etc. to your
instructor(s). You save a file by clicking on ‘Add File’. To send a file, click on
‘Send File’.

Glossary: Terms entered by your instructor(s).

Homepage: Create a website featuring text, images/pictures and links to other
websites.

My Grades: View grades which have been awarded via Blackboard.

Personal Information: Here you may change your personal information, install
CD-Rom drives etc. Note: You CANNOT change password.

Tasks: View tasks.

The Electric Blackboard: Here you may enter notes.

User Manual: Contains the Blackboard manual for students.
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2) ORGANIZATIONS

The Blackboard Organizations System is a module which offers all users the option of
having a *Blackboard space’ which is not constituted by a course offered by the
University of Southern Denmark. An “organization’ is shared by a group of individuals
affiliated with SDU who wish to cooperate on something academic or non-academic, e.g.
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inter-disciplinary collaborations, study groups, party organisations etc. It is available as a
submenu under the Courses-tab.

If you want an organization, you must fill out an application form found in the About
Organizations box with the following information:

- Organization name.

- The full name of the person responsible for the organization.

- The SDU e-mail address and e-learn user name of the person responsible for the
organization.

- A brief description of the purpose of the organization you wish to create.

On the ‘Organizations’ tab you find:

1. Abox (“My Organizations’) which contains a list of the organizations in which you
participate.

2. The ‘About Organizations’ box, which contains information on the use of
organizations at elearn.sdu.dk.

3. The “‘Organizations Catalog’ box, where you may view a list of all existing
communities at SDU.

4. Under ‘Institution Discussion Boards’, you’ll find various relevant fora — for instance
you may contribute input regarding the content on the > Organizations’ tab.

5. Edublog.sdu.dk — most recent posting: Link to the SDU edublog at
http://edublog.sdu.dk.

3) MY PAGE
My page is your personal area in Blackboard. Here you find all the functions in the
submenu which has a personal link to your user:

m What's Mew | Self Senvice m
From the 'My Page’, you have direct access to your
sdu-mail, self-service and your expo site. 00ls

& Announcements

To the left, a number of tools are available in the & User Directory
“Tools’ menu. B My Grades

k< Send Email

&) Address Book

B Personal Information
[= Calendar
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The most important of these are:

e Announcements: Announcements in connection with the courses in which are
enrolled. In the roll-down menu in the right hand corner, you choose to view
announcements from all courses or a specific course. Please note the time tabs. If
you have not accessed the pages for a while, you should choose to view
announcements going back a considerable time

e Calendar: Overview of events/meetings planned. Besides you, your instructor(s)
and the system administrator can add events. Via the roll-down menu, you can
choose which types of events you wish to view.

You enter events into the calendar by:

- going to ‘Calendar’ via “Tools’

- choosing Create Personal Event.

- entering a title and, if applicable, a description, then entering the time of the
event

- click on “‘Submit’ — and then on *Ok’

- and subsequently on ‘Ok’

e Send E-mail: Offers the option of sending e-mail to persons enrolled in the same
Courses as you:
You send e-mail by
- going to ‘Send Email’ via ‘Tools’
- clicking in the course to which the e-mail recipient(s) are connected
- choose recipient(s)
- enter the subject next to ‘Subject’, and the text itself next to “Message’ under
‘Enter Message Details’.
- you may attach a file by clicking on “Add’ under ‘Add Attachments’
- click on “Submit’.
Note: it is only possible to send, not to receive, e-mail in Blackboard. Also, there
is no “out box’ in which you can see which e-mails you have dispatched. You
will, however, be able to find these in your own e-mail.

e Address Book:
Here, you may add contacts including the relevant addresses, phone numbers etc,
and subsequently search among these.

e Personal Information:
These are the most important options offered here:
- you may change personal information *Edit Personal Information’
- under ‘Set Privacy Options’ you can choose which of your personal information
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should be available to your fellow students and instructors in Blackboard.
NOTE: You cannot change your password under ’Change Password’. Password
settings in Blackboard are updated via the SDU administrative system, STADS,
every night.

You decide the content and layout of your “My Page’. You choose and opt out of content
via the green “Add Module’ button, and choose layout by dragging the boxes to their
destinations.

As mentioned in the above, you navigate between these three main sections via the tabs.
When moving within these sections, at the top a navigation bar:

G o N ETS G a p TEl pe l Le=e LA  TE8 [ocumentz - Gamle optagelser

This shows your location within the structure, and enables you to go back in your
process as the title of each different sections function as a link.

4) CONTENT SYSTEM

The Blackboard Content System can be thought of as an
online disc drive, on which you can save all material. On  EASEE ST
the left hand side of the page under the ‘Content System’  # My Content

tab, up to three essential sections may be displayed: a
‘My Content’section (your personal disc space), possibly
a “Course Content’ section (disc space reserved for your
various courses — only in special cases you have Course
Content space) and, if applicable, a “Organization ¥ Course Content
Content’ section (disc space reserved for the ¥ Organization Content
communities of which you are a member). ‘Course
Content” and ‘Organization Content’ contain a folder for
each of the courses/communities in which you participate.

=5 users
= rokritest

# |nstitution Content

Your personal disc drive in “My Content” makes 100 Mb available to you.

Adding Folders and Documents
When creating folders or files, use the green buttons:

Content Collection: My Content
| Upload ¥ || Create Folder
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The button 'Upload' has two downward arrows on them. This indicates that a submenu
appears when you mouse over it.

Creating a Folder:

You create a folder by clicking on “Create Folder’. In the submenu which now appears
you only need to fill in “‘Folder Name’, and then click on ‘Submit’. Remember to give the
folder a descriptive name so it is easy to navigate later.

Content Collection: My Content

- Upload <

Create Folder

Folder Name |Testfolder Cancel | Create and Customize | Submit

Add Document
You add a file (to the folder you are in) by clicking on
‘Item’.

lpload Files
In the top right corner, you should now choose whether > Upload Package
you want to upload a single file or several:

Single File Multiple File=

In the display which now appears, click on ‘Browse’, find, in your own computer, the
document you wish to copy into Content System, double click on it, or highlight it and
click on “‘Open’. Now, in the Blackboard display, click on ‘Submit’.

To add multiple files or an entire folder, you can, in ‘Multiple Files', drag files into the
window, and then upload them all at once.

You can link from the course to the files you have placed in Content System. See below
under ‘Adding a Document or Folder....’

Adding a document or folder from the Blackboard *Content System’ to an
organization

When you add a document or folder from *Content System’ to an organization, you are
not placing a copy herein; rather, a link is created from the organization to the document
or folder in *Content System’. This means that you can use the same material in several
places without having to make multiple copies. This also means that you only need to
manage and update one location.
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When linking from an organization, go to the forum via the *Organizations’ tab under
Courses. Click on “Control Panel’ and choose the section in which the material is to be
placed, e.g. ‘Documents’.

Before you can edit the content, remember to put the 'Edit mode' ON in the top right
corner:

A0 on
In the tool bar (the green buttons), choose ‘Item’.

Build Content % J| Create Assessment % || Add Interactive Tool % | Assign Textbook

Create New Page Mashups

¥ ltermn » Content Folder » Flickr Photo

» File » Blank Page » SlideShare Presentation
G R > Module Page *YouTube Video

> Image » Tools Area

» Video

* URL

» Learning Module
» Lesson Flan

» Syllabus

» Course Link

Enter a name in the ’Name’ panel, and, if applicable, a description in the "Text’ panel.
Next to "2. Attachments’: click on ‘Browse Course Files’ to search for the file or folder in
"Content System’.

Attach afile from a local drive, Course Files, orthe Content Collection. All attached files are s:

not deleted.
Aftach File Browse My Computer | Browse Course Files |
Mark the file or
folder, then click
on ‘Submit’. A
text box will
appear with a % =
warning that the [Doc ]
file or folder will
now be displayed O Invitation til
Lasninasforslag pa Connect.docx
hiemmeopgaver.swi Size 118.3 KB
Size 453 B KB

Selected Files: 1 E Cancel Submit
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to course participants. Click on ‘OK’

You can enter a title next to "Link Title’, if you want the students to click on a string of

text rather that the link path to open the file. Then, simply click on *Submit’, followed by
‘OK”.

If you have questions, comments or problems understanding this guide you are welcome
to mail us at elearn@sdu.dk. We will get back to you within three working days.
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